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Abstract 

L’uMlizzo di strumenM automaMci per processare ed analizzare segnali 

ele@roencefalografici (EEG) risulta sempre più uMle in quanto perme@e di ripulire i 

segnali da eventuali rumori o artefaG, perciò risulta una fase fondamentale per una 

migliore comprensione del segnale da parte del clinico e quindi per una migliore 

diagnosi. Si analizzano gli EEG prelevaM da 3 soggeG affeG da Epilessia Ipermotoria del 

Sonno (SHE), presenM all’interno del CAP Sleep DataBase di Physionet, con l’uMlizzo di 

EEGLAB, un toolbox a interfaccia grafica di Matlab. La diagnosi della SHE risulta 

parMcolarmente difficile, per questo si vuole trovare un metodo che perme@a di 

riconoscere pa@ern anomali all’interno degli EEG dei soggeG che ne sono affeG. La 

parte più esterna del Sistema Nervoso Centrale è la corteccia cerebrale, che risulta 

formata da parMcolari neuroni, deG corMcali, tra cui si trovano i neuroni piramidali: 

gruppi di neuroni che, se sincronizzaM tra loro, generano il segnale EEG. Il segnale EEG 

viene prelevato mediante ele@rodi posM sullo scalpo del sogge@o secondo uno 

standard, il Sistema Internazionale 10/20; nel segnale EEG si possono disMnguere 

cinque ritmi principali in base alla banda di frequenze occupate. I 3 soggeG tra@aM 

sono affeG da Epilessia Ipermotoria del Sonno, un’epilessia focale classificata come 

malaGa rara, la cui mancata diagnosi porta ad una peggiore qualità della vita degli 

individui che ne soffrono e ad un peggioramento stesso della malaGa nel tempo, se 

vengono somministrate cure sbagliate. L’analisi dei segnali è parMta da una fase di 

preprocessamento in EEGLAB: caricamento del segnale, inserimento delle Channel 

LocaMons (posizioni degli ele@rodi), filtraggio, decomposizione delle ComponenM 

IndipendenM (ICA). UMlizzando un plugin di EEGLAB, ICLabel, è possibile classificare 

automaMcamente le componenM in varie classi (cerebrale, oculare, muscolare, 

cardiaca, rumore di linea, rumore del canale, altro) e quindi eliminare quelle che 

presentano un’elevata percentuale di artefaG al loro interno. Infine, vengono 

analizzate in de@aglio le onde delta in prossimità e lontano dalle crisi; infaG in 

le@eratura sono presenM studi che evidenziano una prevalenza delle onde delta 

rispe@o ai ritmi più veloci in soggeG affeG da SHE. Per due soggeG su tre, le onde 

delta risultano di ampiezza e numero maggiore prima e durante l’onset di una crisi 

epileGca, in parMcolare nei canali riferiM agli ele@rodi F8, T4, F7 e T3. Nell’altro 

sogge@o questa aGvità anomala delle onde delta risulta poco presente, per cui 

analizzando traG di segnale non in prossimità delle crisi, ne risultata che anche i traG 



interictali possono essere cara@erizzaM da anomalie: è stato riscontrato che quesM 

traG presentano un andamento in cui prevalgono le onde delta sulle onde a più alta 

frequenza. Sulla base di quanto rilevato, possiamo concludere dicendo che, mediante 

l’uMlizzo di strumenM automaMci, si possono trovare facilmente le varie anomalie sopra 

descri@e, cara@erisMche dei soggeG affeG da SHE, che saranno di grande aiuto al 

clinico per effe@uare la diagnosi.  
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Introduzione 

L’analisi e lo studio dell’epilessia sono ampiamente tra@aM in le@eratura. Tu@avia 

esistono numerosi Mpi di epilessia classificaM come rari che presentano una tra@azione 

e uno studio non ancora oGmale per la loro diagnosi e tra@amento. 

Tra quesM c’è l’Epilessia Ipermotoria del Sonno. Si tra@a di un’epilessia focale, 

cara@erizzata dalla presenza di episodi epileGci quasi esclusivamente durante il sonno, 

il che può causare una frammentazione del sonno e una conseguente stanchezza e 

sonnolenza al momento del risveglio. 

La diagnosi dell’Epilessia Ipermotoria del Sonno viene fa@a mediante la rilevazione del 

segnale ele@roencefalografico, ma può risultare difficoltosa per vari moMvi. Un primo 

moMvo è sicuramente il fa@o che le crisi avvengono soltanto durante il sonno, il che 

rende meno agevole la misurazione dell’aGvità ele@rica del paziente; a questo si 

aggiungono i movimenM causaM dalle crisi, che creano molto rumore nel segnale. 

Anche nel caso in cui si riesce a prelevare un segnale ele@roencefalografico durante la 

no@e e senza troppo rumore, ci sono delle problemaMche che insorgono nella le@ura e 

nell’interpretazione del segnale. InfaG la registrazione ele@roencefalografica dello 

scalpo potrebbe non presentare alcuna anomalia anche durante gli a@acchi e, se 

vengono rilevate delle aGvità anomale, esse possono essere confuse con le parasonnie 

(episodi di confusione no@urna, non epileGci). Una diagnosi sbagliata ha ripercussioni 

sulla qualità della vita del paziente, in quanto viene fornito un tra@amento errato e la 

patologia potrebbe peggiorare nel tempo. 

Lo scopo della tesi è quello di proporre, con l’aiuto della le@eratura, un metodo che ci 

perme@e di riconosce le anomalie comuni presenM nell’ele@roencefalogramma di 

soggeG affeG da Epilessia Ipermotoria del Sonno.  

Sono staM condoG un preprocessamento e un’analisi del segnale tramite l’uso di 

EEGLAB, un toolbox a interfaccia grafica di Matlab, con lo scopo di ripulire il segnale 

originale e di isolare il ritmo che secondo la le@eratura presenta parMcolari anomalie 

nei soggeG affeG da Epilessia Ipermotoria del Sonno: il ritmo Delta.  
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Capitolo 1  

Il Sistema Nervoso Centrale: anatomia e 

fisiologia della corteccia cerebrale 

Il Sistema Nervoso Centrale (SNC) è la parte del Sistema Nervoso che comprende 

encefalo e midollo spinale, contenuM e proteG dal cranio e dalla colonna vertebrale.[1] 

In tuG i componenM del SNC si può disMnguere una sostanza bianca, formata da assoni 

mielinizzaM, e una sostanza grigia, ricca di somi, dendriM e assoni non  mielinizzaM.[2] 

L’83% dell’encefalo è composto dal cervello, mentre cervelle@o e tronco cerebrale 

formano il restante. Concentreremo l’a@enzione sul cervello, diviso in emisfero destro 

ed emisfero sinistro, e in parMcolare sulla sua parte più esterna, la corteccia cerebrale. 

La sostanza grigia nel cervello si trova nella parte più esterna e forma la corteccia 

cerebrale: uno strato spesso da 2 a 3 mm che presenta una grande quanMtà di giri e 

solchi; queste circonvoluzioni perme@ono al tessuto, che ha un’estensione di alcune 

cenMnaia di cenMmetri quadri, di entrare nel piccolo spazio della volta cranica. 

La corteccia cerebrale è formata da un tessuto, chiamato neocortex, arMcolato in 6 

straM la cui composizione varia da zona a zona in termini di spessore, composizione 

cellulare, connessioni sinapMche, dimensioni dei neuroni e desMnazione degli assoni. 

Possiamo disMnguere una corteccia primaria, formata da quelle regioni che ricevono 

sMmoli dagli organi di senso o dal tronco encefalico e dalle zone che mandano le fibre 

nervose motorie al tronco encefalico, il quale distribuisce i comandi motori ai nervi; e 

una corteccia associaMva, che rappresenta la maggior parte della corteccia cerebrale, e 

gesMsce l’interpretazione delle afferenze sensoriali, la pianificazione delle efferenze 

motorie, i processi cogniMvi e la conservazione e il recupero della memoria. 

1.1 Aree della corteccia cerebrale 

I giri, sopra nominaM, sono le parM arrotondate che sporgono e che si vedono quando 

osserviamo la superficie esterna del cervello; mentre i solchi sono le parM affossate che 

dividono i giri. Alcune di queste pieghe hanno posizioni variabili da individuo a 

individuo e tra gli emisferi, mentre altre hanno posizioni fisse che perme@ono di 
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individuare qua@ro diverse zone sulla corteccia cerebrale, de@e lobi, disMnte in 

parMcolare per le funzioni svolte (Figura 1.1).[1] 

- Lobo frontale 

 È il lobo più grande del cervello; è localizzato dietro l’osso frontale e si estende 

fino ad un solco verMcale, la scissura centrale. Può essere suddiviso ulteriormente in 

diverse aree in funzione dei ruoli svolM; ci sono aree deputate al controllo motorio, il 

cui danneggiamento porta a stanchezza e a movimenM ridoG nella parte controlaterale 

del corpo. Altre aree controllano il linguaggio, come l’area di Broca, e una loro 

alterazione comporta un linguaggio non più fluente.[3] È anche responsabile del 

ragionamento, delle decisioni e in generale dell’espressione della personalità 

dell’individuo.[4] 

- Lobo parietale 

 Forma la parte superiore dell’encefalo e si estende dalla scissura centrale fino 

alla scissura parieto-occipitale; è responsabile della percezione e di alcune funzioni 

connesse con l’elaborazione visiva, oltre che del processamento delle informazioni 

provenienM dai sensi.[1] I neuroni del lobo parietale ricevono le informazioni dai 

sensori di tu@o il corpo, li processano e capiscono cosa viene toccato a parMre da 

conoscenza passata.[5] 

 

Figura 1.1: Visione superiore (a) e laterale (b) della corteccia cerebrale; si possono 

idenMficare le diverse aree della corteccia e i principali solchi che le dividono e 

idenMficano. [1] 
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- Lobo occipitale 

 Localizzato nella regione posteriore, si trova dietro la scissura parieto-occipitale; 

è il centro per il processamento degli input visivi.[1] Riceve informazioni dalla reMna e 

usa esperienze visive passate per interpretare e riconoscere gli sMmoli.[5] 

- Lobo temporale 

 Si trova nella zona laterale del cervello ed è separato dal lobo parietale, che si 

trova superiormente, tramite la scissione laterale; è connesso con le funzioni udiMva, 

olfaGva, con l’apprendimento e 

 la memoria.[1] 

1.2 Neuroni corRcali 

La corteccia cerebrale è organizzata in 6 straM, composM da due Mpi di cellule: i neuroni 

eccitatori e i neuroni inibitori. [6] 

I neuroni eccitatori, anche deG cellule piramidali per la forma piramidale del loro 

soma, sono cara@erizzaM dalla presenza di un dendrite apicale predominante che punta 

verso la superficie della corteccia, dove forma numerose ramificazioni, le spine 

dendriMche (Figura 1.2). Hanno un solo assone e dalla parte basale del soma partono 

ulteriori dendriM che formano altre ramificazioni. Queste cara@erisMche sono comuni a 

tuG i neuroni piramidali, ma la loro forma e funzione può essere diversa in base alla 

zona corMcale o allo strato della corteccia nel quale si trovano.[7] Le cellule piramidali 

possono stabilire connessioni sia localmente che a lungo raggio, passando anche 

a@raverso la sostanza bianca. 

I neuroni inibitori hanno una morfologia molto diversa tra loro (ne esistono fino a 50 

Mpi diversi), nonostante siano presenM in minor numero nella corteccia. Sono anche 

deG interneuroni in quanto, a differenza dei neuroni eccitatori, stabiliscono 

connessioni solamente locali e quindi si trovano solo all’interno della sostanza grigia.[6] 
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Figura 1.2: Ricostruzione di una cellula piramidale. Soma e dendriM sono in rosso, 

mentre l'assone e le sue diramazioni sono in blu. 1)Soma 2)Dendrite basale 3)DendriM 

apicali 4)Assone 5)Assone collaterale 

1.2.2 Potenziale d’Azione 

L’informazione trasferita dai neuroni si trova so@o forma di un potenziale d’azione (AP). 

Tra interno ed esterno di una cellula si può calcolare un potenziale, de@o di riposo, pari 

a 60-70 mV con polarità negaMva; quando questo potenziale di riposo varia (aumenta) 

e raggiunge una certa soglia, allora si genera un potenziale d’azione.[8] 

Il potenziale d’azione viene generato dall’apertura di parMcolari canali che perme@ono 

il passaggio di ioni a@raverso la membrana, aGvaM da sMmoli di diversa natura (chimici, 

ele@rici, visivi, ecc.).  

La variazione del potenziale di membrana è dovuta in parMcolare all’apertura di canali 

per il passaggio di sodio e di potassio: in condizioni di riposo il sodio ( ) è 

maggiormente concentrato all’esterno della cellula e il potassio ( ) all’interno e per 

mantenere il potenziale di riposo è presente la Pompa Sodio-Potassio, che lavora 

contro gradiente. Lavorando contro gradiente, la Pompa Sodio-Potassio perme@e lo 

scambio di ioni solo in presenza di energia, so@o forma di molecole di ATP; per ogni 

molecola di ATP, la pompa trasporta 3  dall’interno all’esterno della cellula e 2  

Na+

K+

Na+ K+
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dall’esterno verso l’interno. Lo scambio non è ele@ricamente neutro e questo fa in 

modo che la cellula accumuli più cariche posiMve all’esterno rispe@o all’interno, 

generando un potenziale di riposo negaMvo. [9] 

Quando la cellula sente uno sMmolo, si apre il canale che fa entrare il sodio all’interno 

della cellula, causando un aumento del potenziale di membrana (depolarizzazione). Se 

il potenziale raggiunge la soglia di -55 mV si innesca un potenziale d’azione e si aprono 

ancora più canali di  fino ad arrivare ad un potenziale posiMvo. RaggiunM i +30 mV, 

si chiudono i canali del sodio e si aprono i canali del potassio che esce dalla cellula e fa 

diminuire il potenziale (ripolarizzazione).  

Prima di tornare al potenziale di riposo c’è una fase, de@a di iperpolarizzazione, nella 

quale il potenziale è minore del potenziale di riposo (-90 mV); si tra@a di un periodo 

refra@ario che garanMsce l’unidirezionalità dello sMmolo, infaG se una cellula in fase di 

iperpolarizzazione viene colpita da uno sMmolo, il potenziale aumenta ma non riesce a 

raggiungere la soglia e non si crea il potenziale d’azione.[8] La figura 1.3 descrive le 

variazioni del potenziale nel tempo. 

 

Figura 1.3: Schema di un potenziale d’azione nel tempo in seguito ad uno sMmolo 

Na+

5



1.2.1 Connessioni tra neuroni: Sinapsi 

Nell’uomo ogni neurone stabilisce connessioni con circa 10,000 altri neuroni; le 

connessioni possono avvenire tra i dendriM di una cellula e l’assone o i dendriM di altre 

cellule e perme@ono alla cellula neuronale di ricevere impulsi da altri neuroni o di 

trasme@ere il segnale ad altre cellule, cioè perme@ono l’integrazione neurale 

(elaborazione dell’informazione).[8][1] 

L’incontro tra assone e dendriM o tra dendriM e dendriM avviene in corrispondenza di 

una giunzione, de@a sinapsi.[1]  

Il potenziale di riposo della membrana può variare durante le aGvità sinapMche e 

scorrerà lungo la fibra nervosa fino alla sinapsi, che può essere una sinapsi eccitatoria o 

inibitoria. Nel caso di una sinapsi eccitatoria nel neurone che segue si genera un 

potenziale eccitatorio post-sinapMco; se più potenziali eccitatori post-sinapMci scorrono 

lungo lo stesso neurone a poca distanza l’uno dall’altro, si possono sommare e, 

superata una certa soglia, generare un potenziale d’azione.  

Se la sinapsi è inibitoria, si genera un potenziale post-sinapMco inibitorio che determina 

un’iperpolarizzazione.[8] 
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Capitolo 2 

Il segnale eleHroencefalografico 

L’ele@roencefalografia è una tecnica che ci perme@e di rilevare l’aGvità ele@rica del 

cervello umano, cioè ci perme@e di registrare il segnale ele@roencefalografico, o 

ele@roencefalogramma (EEG).[10] 

La prima applicazione dell ’EEG nell ’uomo risale al 1924; dagli inizi 

dell’ele@roencefalografia ad oggi sono staM faG innumerevoli progressi che ci 

perme@ono di usare l’EEG come strumento per la scoperta, per la diagnosi e per il 

tra@amento di anormalità a livello sia neurologico che psicologico nel cervello e nel 

resto del SNC.[8] 

L’ele@roencefalogramma deriva dalla somma dell’aGvità ele@rica di più neuroni che, 

essendo cellule eccitabili, producono campi ele@rici e magneMci. QuesM campi vengono 

rilevaM a@raverso un dato numero di ele@rodi che nel caso dell’EEG sono posizionaM 

sullo scalpo; allora dovremo considerare che tra sorgente ed ele@rodo intercorrono 

diversi straM (cranio, cervello, liquido cerebrospinale, ecc.) che a@enuano il segnale 

generato.[8][11] 

2.1 Origine del segnale eleHroencefalografico 

I neuroni, come abbiamo visto, possono essere eccitaM e generare correnM ele@riche 

tempo-varianM; queste correnM vengono rilevate mediante l’EEG solo se sono di 

ampiezza opportuna. Per questo moMvo le uniche correnM raccolte sono quelle dei 

neuroni piramidali, i quali hanno una disposizione parMcolare che perme@e la 

generazione di un segnale ele@rico abbastanza ampio.  

L’aGvazione neuronale può avvenire con l’arrivo di un potenziale d’azione, quindi con 

la depolarizzazione della membrana mediante l’aGvazione dei canali voltaggio-

dipendenM di sodio e potassio; o con le aGvazioni sinapMche, che perme@ono la 

formazione di potenziali post-sinapMci eccitatori o inibitori. Nel caso di potenziali post-

sinapMci eccitatori le correnM sono generate dall’ingresso di ioni posiMvi (come ) 

nella cellula; nel caso di potenziali post-sinapMci inibitori le correnM sono generate 

Na+
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dall’entrata di ioni negaMvi (come ) o dall’uscita di ioni posiMvi (come ) dalla 

cellula.[11] 

2.1.1 Dipoli di corrente 

A livello di una sinapsi eccitatoria si genera un flusso di ioni posiMvi dire@o verso 

l’interno della cellula e si crea quello che viene chiamato pozzo aGvo (sink); mentre, a 

livello di una sinapsi inibitoria è presente un flusso di ioni posiMvi che vanno 

dall’interno verso l’esterno della cellula, per cui si crea una sorgente aGva (source). 

[11]  

In entrambi i casi, per compensare questo flusso di ioni, nella membrana neuronale si 

generano delle correnM opposte a quella presente, che danno origine a pozzi o 

sorgenM, entrambi passivi. 

Nel caso si un potenziale post-sinapMco eccitatorio, si genera un pozzo aGvo e per 

compensarlo una sorgente passiva; nel caso di un potenziale post-sinapMco inibitorio, si 

genera una sorgente aGva che viene compensata da un pozzo passivo. In questo 

modo, ogni volta che si verifica un’aGvazione sinapMca ci si riconduce ad una 

configurazione sink-source, cioè si creano dei dipoli di corrente tra il soma e i dendriM 

apicali (Figura 2.1). [8][11] 

Il segnale ele@roencefalografico misura proprio queste correnM che scorrono quando i 

neuroni vengono eccitaM. 

2.1.2 Neuroni piramidali 

La tecnica maggiormente usata per registrare il segnale ele@roencefalografico è quella 

non invasiva e usa parMcolari ele@rodi posizionaM sullo scalpo del paziente. Tra i 

neuroni che generano il segnale e gli ele@rodi intercorrono diversi straM, come il cranio 

e lo scalpo, i quali a@enuano il segnale di un’enMtà che dipende dalle cara@erisMche 

dello strato (il cranio a@enua il segnale circa cento volte di più rispe@o al tessuto 

morbido). 

Affinché un segnale sia captato dagli ele@rodi, esso deve avere una certa ampiezza, 

cioè riusciamo a registrare solo segnali provenienM da larghe popolazioni di neuroni 

aGvi, i cui contribuM si sommano. Il maggiore contributo all’EEG è dato dai neuroni 

piramidali, i cui dendriM apicali sono perpendicolari alla superficie corMcale e paralleli 

tra di loro; in parMcolare è dato dalle correnM originate dalle aGvazioni sinapMche nei 

dendriM delle cellule piramidali. Quando si raggiunge un certo livello di sincronia, le  

Cl− K+
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Figura 2.1: Schema delle correnM e dei potenziali post-sinapMci generaM in 

un’aGvazione sinapMca nel caso di una sinapsi eccitatoria e di una sinapsi inibitoria. Il 

potenziale generato da una sinapsi eccitatoria è indicato come PPSE e quello generato 

da una sinapsi inibitoria è de@o PPSI. [11] 

linee di flusso dei neuroni piramidali si sommano e si genera un campo ele@ro-

magneMco rilevabile dagli ele@rodi sullo scalpo.[8][11] 

I singoli dipoli non sono però sempre sincroni e possono cambiare modulo e verso nel 

tempo; quesM cambiamenM si traducono nelle oscillazioni presenM nel tracciato 

ele@roencefalografico.[12] 

2.2 Acquisizione del segnale eleHroencefalografico 

L’acquisizione del segnale ele@roencefalografico avviene mediante uno strumento, 

chiamato ele@roencefalografo, che può essere sia analogico che digitale. Lo strumento 

analogico è formato da: 

• ele@rodi, che saranno posizionaM in dei punM standard dello scalpo; 

• sistema di acquisizione, composto da un insieme di amplificatori differenziali, pari al 

numero di canali dell’ele@roencefalografo e da parMcolari filtri;  

• penna meccanica e sistema scrivente per tracciare il segnale su carta. 
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Oggi ci sono ele@roencefalografi digitali, nei quali si opera una conversione analogico/

digitale e la penna e il sistema scrivente sono sosMtuiM da un preprocessore e da un 

monitor, sul quale viene visualizzato il segnale; in questo modo l’EEG può anche essere 

memorizzato in formato digitale.[8][13] 

L’ele@roencefalogramma è molto usato per la diagnosi e il monitoraggio dell’epilessia, 

per diagnosMcare disturbi del sonno o semplicemente per monitorare il sonno, oltre 

che come esame aggiunMvo per traumi o malaGe neurologiche. [14] 

2.2.1 Ele9rodi per EEG 

Gli ele@rodi per EEG e le loro cara@erisMche sono fondamentali per o@enere un 

segnale di qualità. Hanno il compito di trasdurre le correnM ioniche in correnM 

ele@riche, che vengono poi trasportate a@raverso dei cavi condu@ori che collegano gli 

ele@rodi al sistema di acquisizione. 

Gli ele@rodi usaM possono essere di vario Mpo (Figura 2.2): 

• Monouso (con o senza gel); 

• Ele@rodi riuMlizzabili, composM da oro, argento, acciaio inossidabile; 

• Ele@rodi ad ago, tecnica più precisa ma anche più invasiva. 

In generale, gli ele@rodi più uMlizzaM sono dischi formaM da stagno e da argento rivesMM 

di cloruro di argento (Ag/AgCl). Per rilevare il potenziale da numerosi punM dello 

scalpo, cioè quando vogliamo uMlizzare un ele@roencefalografo mulMcanale, si usano 

delle cuffie indossabili con ele@rodi incorporaM (Figura 2.3). [8][14][15] 

Gli ele@rodi vengono denominaM con una le@era e un numero in base alla loro 

posizione sullo scalpo. 

Un parametro da controllare è l’impedenza degli ele@rodi, che per la sicurezza del 

paziente deve rimanere bassa (so@o i 5kΩ); infaG viene messo un gel 

ele@rocondu@ore tra ele@rodo e pelle con lo scopo di favorire l’adesione dell’ele@rodo 

alla cute.[14] 

2.2.2 Misurazioni 

Il segnale di un canale viene rilevato sempre a parMre da due ele@rodi, che possono 

trovarsi in una configurazione referenziale o bipolare. 

In una configurazione referenziale (o monopolare) si rileva la differenza di potenziale 

tra un ele@rodo aGvo e un ele@rodo di riferimento (lo stesso per tuG i canali), che può 

essere un altro ele@rodo nel corpo (spesso si usa l’ele@rodo posto sul lobo destro o 
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sinistro) o si può fare un riferimento medio (si usa il segnale o@enuto dalla media dei 

segnali rilevaM da diversi ele@rodi). 

Figura 2.2: Tipi diversi di ele@rodi: ele@rodi monouso (A), ele@rodi di Ag/AgCl (B), 

ele@rodi ad ago (C). Gli ele@rodi rappresentaM in figura B sono parMcolari ele@rodi 

formaM da argento e rivesMM di cloruro di argento, deG “a coppe@a”. 

 

Figura 2.3: cuffia per ele@rodi. La cuffia è formata da una serie di fori nei quali verranno 

inseriM gli ele@rodi con i quali si vuole fare la misurazione; vicino ad ogni foro c’è scri@o 

il nome dell’ele@rodo corrispondente. 
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In una configurazione bipolare si rileva la differenza di potenziale tra due ele@rodi 

qualsiasi sullo scalpo del paziente. [16] 

2.2.3 Sistema Internazionale 10/20 

La Federazione Internazionale delle Società di Ele@roencefalografia e Neurofisiologia 

Clinica ha stabilito un sistema standard per il posizionamento degli ele@rodi sullo 

scalpo. Il sistema considera 21 ele@rodi e comprende due ele@rodi posM sui lobi destro 

e sinistro (A1 e A2) che sono spesso usaM come ele@rodi di riferimento. Gli altri 

ele@rodi sono posizionaM a parMre da punM di repere anatomici:  

• Nasion: solco che si trova nella parte alta del naso, a livello con gli occhi 

• Inion: protuberanza del cranio che si trova nella parte posteriore della testa, lungo la 

linea mediana 

• PunM preauricolari 

Inion e Nasion definiscono la linea mediana antero-posteriore e i punM preauricolari la 

linea coronale latero-laterale. Queste linee ci perme@ono di definire il perimetro del 

cranio; le posizioni degli ele@rodi sono state definite dividendo quesM perimetri in 

segmenM con lunghezza pari al 10% o al 20% della loro lunghezza. [17] 

TuG gli ele@rodi pari sono posM nella parte destra dello scalpo, mentre tuG gli 

ele@rodi dispari si trovano nella parte sinistra. La disposizione degli ele@rodi secondo il 

sistema 10/20 è rappresentata in Figura 2.4. 

Figura 2.4: Posizioni degli ele@rodi sullo scalpo secondo il sistema 10/20: visione 

laterale (A) e visione dall’alto (B). I punM indicaM (Inion, Nasion, punM preauricolari e 

Vertex) sono i punM di repere anatomici dai quali sono state definite le posizioni degli 

ele@rodi. [17] 
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2.3 Morfologia e composizione armonica del segnale eleHroencefalografico 

Il segnale EEG è uno dei segnali più difficili da analizzare, anche a causa del suo 

andamento non periodico (non sono presenM moMvi che si ripetono ad intervalli 

regolari lungo il tracciato). Ha un ampiezza che può andare da pochi microvolt a poche 

cenMnaia di microvolt (10-100 µV) e può essere visualizzato nel tempo e in frequenza.  

Il range di frequenze considerato quando si acquisisce un EEG si estende normalmente 

da 1 a 50 Hz, anche se le massime componenM del puro segnale EEG si trovano intorno 

ai 30 Hz (Figura 2.5). Nonostante le componenM fisiologiche hanno un massimo di 

frequenza a 30 Hz, si possono mandare al paziente degli sMmoli (visivi, udiMvi, ecc.), i 

quali innescano una reazione nel sogge@o e si rifle@ono sull’EEG, generando quelli che 

vengono chiamaM Potenziali EvocaM. I potenziali evocaM possono avere componenM a 

frequenze molto superiori rispe@o ai potenziali EEG (anche intorno ai 3000 Hz). [14] 

L’ampiezza e le frequenze occupate dall’EEG dipendono da molM fa@ori: dall’età, 

dall’aGvità svolta mentre si effe@ua l’esame (se il sogge@o è sveglio o dorme) e da 

persona a persona. [8] 

Si possono comunque disMnguere cinque onde, de@e ritmi, che si differenziano per il 

range di frequenze occupato (Figura 2.6):  

• Onde Delta (𝛿): sono le onde a più bassa frequenza con componenM tra 0.5-4 Hz. 

Sono associate al sonno profondo, ma possono comparire anche nel primo risveglio e 

nei bambini. 

 

Figura 2.5: spe@ro in frequenza di un segnale EEG [14] 
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Figura 2.6: Andamento nel tempo dei cinque ritmi cerebrali predominanM  

• Onde Teta (θ): hanno componenM tra 4-7.5 Hz. Nei soggeG adulM in fase di veglia 

questa aGvità è generalmente assente, ma appare durante il sonno, mentre si trova 

abitualmente nei bambini. 

• Onde Alfa (ɑ): è il ritmo predominante che occupa la banda tra 8 e 13 Hz. Appaiono 

quando siamo in uno stato rilassato senza parMcolare concentrazione, in parMcolare 

con gli occhi chiusi. 

• Onde Beta (β): le onde beta sono quelle associate a pensiero aGvo e ad aGvità in cui 

è richiesta concentrazione e quindi occupano una banda con frequenze più alte 

(14-26 Hz). 

• Onde Gamma (𝛾): tu@e le onde che si trovano a frequenze maggiori di 30 Hz fanno 

parte del ritmo gamma; sono abbastanza rare e possono essere uMli per confermare 

la presenza di certe malaGe.[8][14] 

L’EEG di un sogge@o sano, adulto, vigile, in riposo sensoriale, rilassato, con gli occhi 

chiusi presenta un’aGvità di fondo in banda alfa che occupa i 2/3 posteriori del capo, la 

regione parieto-temporo-occipitale, simmetrica, sincrona e stabile. I ritmi beta si 

registrano sulle regioni frontali e centrali, i ritmi teta si possono osservare sulle regioni 

temporali spesso frammisM all’alfa, e si osserva la reaGvità del ritmo alfa che viene 

interro@o dall’apertura degli occhi in modo sincrono e asimmetrico sui due emisferi e 

sosMtuito bilateralmente da ritmi rapidi. 
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Oltre ai ritmi sopra descriG si possono idenMficare tre classi di ritmi che vengono 

riconosciuM nelle differenM fasi nel sonno o nel caso in cui si presenM una crisi 

epileGca: 

• Ritmi del sonno. Durante il sonno il cervello alterna due staM funzionali, chiamaM fase 

NREM (Non Rapid Eye Movement) e fase REM (Rapid Eye Movement), che 

cosMtuiscono la macrostru@ura del sonno. Nella fase NREM il cervello si trova a 

riposo e un gran numero di neuroni corMcali si sincronizzano generando segnali con 

ampiezza elevata; la fase NREM si divide in qua@ro ulteriori gradi (stage), che vanno 

dalla sonnolenza (stage I) al sonno molto profondo (stage IV) e ognuno è 

cara@erizzato dalla prevalenza di un certo ritmo, come rappresentato in Figura 2.7. I 

ritmi che compaiono più spesso sono: a) Onde al VerMce (Vertex Waves), che 

cosMtuiscono la risposta a sMmoli esterni e sono cara@erisMche degli stadi più precoci 

del sonno; b) Fusi del Sonno (Sleep Spindles), hanno un andamento simile alle onde 

alfa e sono infaG formaM da onde, de@e Sigma, che hanno frequenza 12-16 Hz;  i fusi 

del sonno compaiono dallo stage 2 del sonno NREM fino al sonno REM con una 

durata che va dai 0.5-1s; c) Complessi K, sono una fusione tra onde al verMce e fusi 

del sonno con un’ampiezza molto elevata e sono molto presenM negli stage III e IV. 

• Punte e Onde aguzze (Spikes and Sharp Waves, SSWs). Sono definite come elemenM 

transienM, cioè onde che risultano più ampie rispe@o al segnale che le circonda e 

sono Mpiche di soggeG epileGci; si presentano tra quelli che sono chiamaM evenM 

Ictali, cioè le crisi epileGche. 

• EEG Ictale. Durante una crisi epileGca, l’EEG è cara@erizzato da un ritmo anormale 

che presenta un grande aumento in ampiezza e un cambio improvviso della 

frequenza che porta ad un pa@ern con onde appunMte (Figura 2.8). [19][20] 
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Figura 2.7: Tipico andamento del segnale EEG quando l’individuo è sveglio e nelle varie 
fasi del sonno. Nell’individuo sveglio c’è una prevalenza di onde alfa e questo 

andamento viene ripreso nel sonno REM, essendo la fase del sonno in cui il cervello è 
aGvo. Nello stage I (sonnolenza) possiamo vedere le onde Teta e alcune onde al 

verMce; nello stage II (sonno leggero) compaiono onde al verMce, fusi del sonno e 
complessi K. Negli stage III e IV (sonno profondo e molto profondo) c’è un andamento 

molto più lento cara@erizzato sopra@u@o da complessi K. 

Figura 2.8: EEG che mostra l’esordio di una crisi epileGca (subito dopo il primo 
secondo), cara@erizzata da un cambiamento nell’ampiezza e nel contenuto spe@rale. 

[18] 
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Capitolo 3 

L’Epilessia Ipermotoria del Sonno 

Per comprendere meglio gli argomenM tra@aM in seguito è bene fare un’introduzione 

sul significato di Epilessia. Secondo le definizioni più recenM l’Epilessia è “una 

disfunzione cerebrale cara@erizzata da una predisposizione prolungata a generare crisi 

epileGche, e dalle conseguenze neurobiologiche, cogniMve, psicologiche e sociali di 

questa condizione” (Fisher et al., 2005) e quindi una crisi epileGca viene definita come 

“un evento transitorio con segni e sintomi dovuta ad un’anormale, eccessiva o sincrona 

aGvità neuronale nell’encefalo” (Fisher et al., 2005). 

Una crisi epileGca può essere: a) Parziale (o focale), interessa una singola area 

cerebrale; b) Generalizzata, coinvolge entrambi gli emisferi. [22] 

L’Epilessia Ipermotoria del Sonno (SHE: Sleep-related Hypermotor Epilepsy) è 

considerata un’epilessia parziale ed è cara@erizzata da una postura asimmetrica del 

sogge@o (tonica o distonica) e/o da complesse crisi motorie che compaiono 

maggiormente durante il sonno. Il termine “ipermotoria” indica che si possono avere 

sia crisi con automaMsmi ipercineMci (automaMsmi cara@erizzaM da aGvità motoria 

involontaria e non coordinata, come lo schiocco delle labbra o lo sfregamento delle 

mani) sia crisi toniche-distoniche (contrazioni muscolari che fanno assumere al 

sogge@o posizioni anomale).  

È stata classificata come malaGa rara con un’incidenza di 1.8/100’000 individui e incide 

sulla qualità della vita dei soggeG che ne sono affeG. [23] 

Può essere sporadica o di Mpo ereditario; quando è familiare viene chiamata Epilessia 

Ipermotoria del Sonno Autosomica Dominante (ADSHE). 

Da vari studi si è concluso che la SHE deriva da variazioni geneMche, anche se ancora 

non si conoscono tuG i geni che la determinano (le mutazioni individuate spiegano 

solo il 30% delle persone affe@e da ADSHE); infaG spesso i familiari di persone affe@e 

da SHE soffrono di parasonnie: disturbi del sonno che consistono in manifestazioni 

indesiderate come risvegli confusionali, sonnambulismo e terrori no@urni. [23][24] 
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3.1 Sintomi e conseguenze dell’Epilessia Ipermotoria del Sonno 

Come già scri@o, i sintomi più evidenM della SHE sono movimenM violenM degli arM e 

postura tonica-distonica durante il sonno. Le crisi sono generalmente di durata 

inferiore ai 2 minuM, ma si possono avere diversi a@acchi per no@e, in parMcolare agli 

esordi della patologia. L’esordio della SHE avviene comunemente durante l’infanzia, 

con alcune eccezioni in età adulta, e sia la gravità sia i sintomi della patologia tendono 

a diminuire nel tempo.[21][23] 

Le crisi avvengono prevalentemente durante il sonno e raramente quando il sogge@o è 

sveglio, in parMcolare si presentano nelle fasi NREM del sonno e raramente nelle fasi 

REM. [16] 

Gli a@acchi possono essere molto violenM e cara@erizzaM da schemi ipermotori con 

aGvità bimanuale o bipede, movimenM pelvici e a volte deambulazione agitata. 

Oltre ai sintomi direG della SHE, ci sono conseguenze sulla qualità della vita delle 

persone che ne sono affe@e.  

Una dire@a conseguenza che si verifica quando gli a@acchi sono numerosi è la 

frammentazione del sonno. Si possono avere da 1 a 20 a@acchi per no@e, oltre che 

episodi motori minori che possono essere anche più frequenM, e questo determina un 

sonno disconMnuo che si ripercuote sul risveglio e sull’intera giornata, causando 

eccessiva stanchezza e inerzia. Quando l’individuo ha un sonno instabile è anche 

maggiormente sogge@o alle crisi epileGche: si crea un loop tra gli a@acchi e i fa@ori 

scatenanM. [21] 

La privazione del sonno porta anche a deficit della memoria e della percezione, oltre a 

comprome@ere il funzionamento dei sistemi cogniMvi collegaM alle reM emoMve. [21] 

3.2 Sindromi dell’Epilessia Ipermotoria del Sonno 

Le manifestazioni della SHE possono essere di diverso Mpo, in parMcolare sono state 

idenMficate 3 sindromi: 

- Eccitazioni parossisMche (paroxysmal arousals, PA): sono una serie di movimenM di 

breve durata (da 2 a 20 secondi) nei quali il sogge@o Mpicamente solleva il capo, si 

alza, si guarda intorno con espressioni di terrore o di sorpresa e alcune volte urla; si 

possono avere numerosi PA per no@e. 

- Distonia parossisMca no@urna (NPD): movimenM no@urni associaM a spasmi tonici, 

che possono essere anche violenM o associaM a vocalizzi; possono inoltre muovere gli 

arM con movimenM ciclici o con calci e assumere una postura distonica della testa, del 

18



tronco e degli arM; la durata degli episodi è maggiore e può andare da 20 secondi a 2 

minuM. 

- Vagabondaggi episodici no@urni (ENW): i soggeG possono scendere dal le@o, 

passeggiare, urlare e avere a@eggiamenM violenM e bizzarri; possono durare da 1 a 3 

minuM. [16][23] 

Mentre le PA sono episodi motori minori, le distonie no@urne e i vagabondaggi sono 

due aspeG delle Convulsioni Ipermotorie (Hypermotor Seizures, HS). [24] 

3.3 Diagnosi dell’Epilessia Ipermotoria del Sonno 

DisMnguere l’epilessia ipermotoria del sonno da parasonnie non epileGche risulta 

difficile per i clinici, in quanto in molM casi di SHE non sono presenM le Mpiche crisi 

convulsive dell’epilessia e appaiono invece schemi comportamentali simili a quelli nelle 

parasonnie. Al 53.7% dei soggeG che soffrono di SHE viene fa@a la giusta diagnosi con 

un ritardo di 12.8 anni, il 55.5% dei quali riceve una diagnosi errata per parasonnie.  

Le conseguenze di una diagnosi errata possono ledere in maniera grave il paziente 

perché gli viene fornito un tra@amento errato e la malaGa potrebbe quindi peggiorare 

nel tempo. [21] 

Questa difficoltà nel disMnguere l’epilessia ipermotoria del sonno dalle parasonnie ha 

portato allo sviluppo di due nuovi strumenM diagnosMci: la scala FLEP (Frontal Lobe 

Epilepsy and Parasomnias) e un’intervista semistru@urata (Structured Interview for 

NFLE/SHE, SINFLE).  

La scala FLEP si arMcola in una serie di punM proge@aM in base alle cara@erisMche della 

patologia; per ogni punto si possono avere più risposte in base ai sintomi presentaM dal 

paziente e ad ognuna si associa un punteggio. In base ai punteggi o@enuM sono staM 

idenMficaM tre range di valori che perme@ono di idenMficare se si tra@a di parasonnie e 

di episodi di natura epileGca. [21][25] 

L’intervista stru@urata (SINFLE) consiste nel valutare la presenza di vari criteri nel 

sogge@o; se il paziente presenta almeno uno dei 2 “criteri maggiori” (pa@ern distonico 

e pa@ern ipercineMco) e almeno 4 dei 13 “criteri minori” dimostra di avere una 

sensibilità del 59.5% nel porre una diagnosi di SHE. 
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Capitolo 4 

Anomalie nel tracciato eleHroencefalografico 

per soggeN affeN da Epilessia Ipermotoria del 

Sonno 

Una delle tecniche maggiormente usare per rilevare a@acchi di epilessia no@urna è la 

registrazione ele@roencefalografica, che migliora l’abilità diagnosMca se accompagnata 

da una registrazione video del sogge@o. Considerando che le crisi sono più frequenM 

quando l’individuo è privato del sonno, gli esami vengono faG quando il sogge@o 

risulta stanco così da aumentare le probabilità di rilevare gli episodi epileGci. 

Non sempre si riescono a rilevare anormalità nel tracciato EEG di soggeG affeG da SHE 

e anche se ci sono delle anomalie è difficile disMnguerle a causa degli artefaG da 

movimento, quindi alcune volte risulta necessario fare un EEG invasivo (ele@rodi ad 

ago). [16] 

Si possono definire alcuni andamenM cara@erisMci in EEG di soggeG epileGci, che 

possono essere racchiusi nel termine “aGvità epileGforme”. Il pa@ern epileGforme 

racchiude diversi andamenM (Figura 4.1): 

- Punta (spike): elemento transiente con un picco appunMto ed una durata che va da 

20 a 70 ms; è considerato un andamento anomalo quando la componente principale 

è negaMva; 

- Onda aguzza (Sharp wave): elemento transiente con una durata da 70 a 200 ms; 

- Complesso punta-onda: punta seguita da un’ampia e lenta onda, che solitamente ha 

un’ampiezza elevata; 

- Complesso di polipunte (polyspike): sequenza di numerose punte; 

- Complesso di polipunte-onda: polipunte seguite da un’onda lenta. 

Se l’EEG registrato non ha rilevato alcuna aGvità ictale, il clinico può comunque 

rilevare delle anormalità nel tracciato; infaG si può ricercare l’aGvità interictale, cioè 

l’aGvità ele@roencefalografica anormale che si presenta negli intervalli tra le varie crisi. 

[16] 
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Figura 4.1: AndamenM delle aGvità epileGformi su una finestra di 10 secondi e una di 

30 secondi 

[h@ps://neupsykey.com/clinical-electroencephalography-and-nocturnal-epilepsy/] 

Inoltre, si possono riconoscere degli elemenM transienM che innescano le crisi 

epileGche, tra cui complessi K e la prima fase (Fase A) di un andamento cara@erisMco 

dell’EEG, de@o Cyclic AlternaMng Pa@ern. 

4.1 Cyclic Alterna4ng Pa9ern 

Il Cyclic AlternaMng Pa@ern (CAP) è un’aGvità periodica dell’EEG che si presenta nelle 

fasi NREM del sonno ed è composta dall’alternarsi di due diversi andamenM dell’aGvità 

ele@roencefalografica. Un ciclo CAP è formato da due fasi: una fase A che corrisponde 

ad un’aGvazione cerebrale ed è quindi formata da complessi di eccitazione, come 

complessi K e delta burst (sequenza di almeno due onde con frequenza da 0.5 a 4 Hz e 

con ampiezza maggiore di quella di fondo), ed ha una durata di 8-15s; e una fase B che 

corrisponde alla deaGvazione cerebrale, quindi coincide con l’aGvità di fondo e separa 

le fasi aGve A con intervalli di 15-20s. 

L’alternanza di fasi A e fasi B cosMtuisce un ciclo CAP se l’intervallo di tempo tra due fasi 

A è <1min; se sono presenM almeno due cicli CAP consecuMvi, si può definire una 

sequenza CAP (Figura 4.2). 
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Figura 4.2: Esempio di cicli e di una sequenza CAP nella fase 2 del sonno NREM 

Possiamo idenMficare anche delle fasi Non-CAP (NCAP), nelle quali l’andamento 

ele@roencefalografico è ritmico e stabile e non sono presenM complessi di eccitazione 

per un periodo >1min. L’organizzazione microstru@urale del sonno è data proprio dai 

CAP e dagli NCAP. 

Sulla base del rapporto tra onde lente ad alta tensione (EEG sincronizzato) e ritmi veloci 

a bassa tensione (EEG desincronizzato) presenM nelle fasi A, quest’ulMme vengono 

suddivise in 3 so@oMpi: 

• So@oMpo A1: composto da complessi K e da onde delta, rappresenta un’aGvità 

sincronizzata che ha un lieve impa@o su aGvità autonome e motorie; 

• So@oMpo A2: formata da evenM sia sincronizzaM che desincronizzaM che hanno un 

impa@o moderato su aGvità autonome e motorie (disincronizzazione moderata); 

• So@oMpo A3: gli evenM sono sopra@u@o desincronizzaM e ha un elevato impa@o su 

aGvità autonome e motorie (desincronizzazione marcata). [26][27][28] 

I cicli CAP sono un’aGvità cerebrale indipendente dalla presenza di qualsiasi a@acco 

epileGco; si tra@a infaG di un ritmo intrinseco del cervello presente nelle varie fasi del 

sonno.  

Le sequenze CAP presenM nel passaggio da sonno leggero a sonno profondo (ramo 

discendente del ciclo del sonno) sono cosMtuite quasi esclusivamente da fasi A1 

ripeMMve; le sequenze CAP che accompagnano il passaggio dal sonno profondo allo 
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stadio più leggero che precede la fase REM (ramo ascendente del ciclo del sonno) sono 

cara@erizzate dai so@oMpi A2 e A3. [27] 

Nel ramo discendente del ciclo del sonno, le sequenze CAP servono per preservare il 

sonno dalle perturbazioni; mentre nel ramo ascendente, servono per alleggerire il 

sonno e preparare il cervello alla fase REM. [29] 

Il CAP, oltre ad essere un fenomeno fisiologico, è anche un indicatore della stabilità del 

sonno e quindi può essere legato a diverse patologie del sonno, come l’epilessia 

ipermotoria del sonno. 

Essendo i cicli CAP periodi di sonno “dinamico”, se sono molto numerosi, sono sintomo 

di un sonno disturbato e instabile; infaG nei soggeG affeG da SHE è stata trovata una 

maggiore percentuale di CAP (CAP rate), oltre che una maggiore durata media dei 

singoli CAP e delle sequenze CAP. [30] 

In uno studio condo@o su 40 soggeG che soffrono di SHE [29], il 90% delle crisi rilevate 

nella fase NREM si sono presentate durante una sequenza CAP e sempre nella fase A 

dei cicli.  

4.2 Variabili del sonno 

Si possono analizzare anche altre misure, de@e variabili convenzionali del sonno, che 

analizzano la distribuzione degli evenM motori epileGci. 

Alcune di queste sono il tempo di sonno totale (TST), latenza del sonno (SL), efficienza 

del sonno (SE), risvegli dopo l’inizio del sonno (Wake A�er Sleep Onset, WASO), 

percentuale di tu@e le fasi del sonno NREM, sonno REM e latenza nella fase REM. 

Le percentuali delle fasi del sonno REM possono essere indicare con S1, S2, S3 e S4 e 

possono combinarsi e dar luogo a due ulteriori parametri: l’insieme di S1 e S2 ci 

perme@e di valutare il sonno leggero; la somma di S3 e S4 ci dà un parametro chiamato 

sonno ad onde lente (Slow Wave Sleep, SWS). 

In pazienM affeG da SHE quesM parametri risultano alteraM rispe@o a quelli di soggeG 

senza alcuna patologia; i parametri WASO e SWS aumentano, indicando quindi una 

maggiore frammentazione del sonno, mentre diminuisce la durata e la percentuale di 

sonno REM. [30] 
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Capitolo 5 

Analisi di tracciaR eleHroencefalografici su 

pazienR affeN da Epilessia Ipermotoria del 

Sonno 

In questo capitolo si descriverà l’analisi fa@a su segnali ele@roencefalografici di pazienM 

affeG a Epilessia Ipermotoria del Sonno. I segnali elaboraM sono staM presi da un 

database presente in PhysioNet [31], il CAP Sleep Database. [26] 

Verranno esposM il preprocessamento e l’analisi dei segnali EEG, i risultaM o@enuM e i 

relaMvi commenM. 

5.1 CAP Sleep Database 

Il CAP Sleep Database raccoglie i segnali polisonnografici (segnali raccolM durante il 

sonno) di 108 soggeG, registraM al Centro dei Disturbi del Sonno dell’Ospedale 

Maggiore di Parma. Per ogni sogge@o sono presenM diversi segnali 

ele@roencefalografici (bipolari, che seguono il sistema 10/20), ma anche 

ele@romiogrammi, segnali respiratori e ele@rocardiogrammi. 

Tra i 108 soggeG, 16 non presentano alcun disturbo neurologico e non hanno assunto 

nessuna sostanza che potrebbe influenzare il sistema nervoso; gli altri 92 sono affeG 

da varie patologie, che hanno in comune il fa@o che nei loro EEG è presente un 

maggior numero di Cyclic AlternaMng Pa@ern (CAP) rispe@o ad un EEG di un sogge@o 

sano. 

Tra i vari soggeG presi in esame nel database, ne sono presenM 40 affeG da Epilessia 

Ipermotoria del Sonno, tra cui ci sono quelli analizzaM in questo elaborato. 

In parMcolare sono staM consideraM 3 diversi soggeG: il sogge@o 1 (nfle1), femmina di 

16 anni; il sogge@o 2 (nfle2), femmina di 41 anni; il sogge@o 7 (nfle7), maschio di 26 

anni. 

Nel database ci si riferisce alla SHE come Epilessia No@urna del Lobo Centrale (NFLE), 

in quanto il database risale al 2012; la conferenza nella quale si è cambiato il nome in 
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Epilessia Ipermotoria del Sonno si è tenuta nel 2014 (Consensus Conference a 

Bologna). [24] 

5.2 Metodo di analisi dei segnali 

Per analizzare i segnali è stato uMlizzato EEGLAB [32], un toolbox a interfaccia grafica di 

Matlab che perme@e di preprocessare segnali EEG e EMG e me@e a disposizione 

numerose funzioni. 

I segnali presenM nel DataBase hanno estensione .edf, quindi per caricare il segnale su 

EEGLAB si seleziona File -> Import data -> Using EEGLAB funcMons and plugins -> From 

EDF/EDF+/GDF file (BIOSIG Toolbox). Viene inserita la lista dei canali da caricare, che  in 

questo caso comprende tuG i canali da 1 a 12, e il range in secondi da selezionare, cioè 

la prima ora di registrazione [0 3600]. 

Dato che il segnale considerato è stato acquisito con un montaggio bipolare, ogni 

canale viene referenziato rispe@o alla media di tuG i canali, Tools -> Re-reference the 

data, dalla finestra che compare si seleziona Compute average reference e poi Ok.  

L’inserimento delle Channel LocaMons, cioè le posizioni degli ele@rodi uMlizzaM per 

prelevare i segnali, si fa selezionando Edit -> Channel LocaMons; si aprirà una finestra 

nella quale si può selezionare il file da cui leggere le channels locaMon, ma per il nostro  

segnale non è disponibile, quindi si può cliccare indipendentemente Cancel o Ok. Si 

apre la finestra nella quale inserire le Channel LocaMons (Figura 5.1): si rinominano i  

canali inserendo solo il primo dei due ele@rodi (es. se ho Fp2-F4, lo chiamo Fp2).  

Una volta rinominaM i canali, il programma è in grado di ricavare le posizioni degli 

ele@rodi in modo automaMco selezionando il tasto ‘Look up locs’; cliccando Ok le 

Channel LocaMons vengono salvate e nella schermata iniziale comparirà Yes. 

Inserendo le Channel LocaMons con questo procedimento visualizzo soltanto i primi 

ele@rodi e non quelli di riferimento; per visualizzare tuG gli ele@rodi si può scrivere 

nella Command Window di MATLAB il seguente codice: 

chanlocs = struct ('labels', {'C3' ‘C4' 'F3' 'F4' 'F7' 'F8' 'O1' 'O2' 'P3' 'P4' 'T3' 'T4' 'T5' 'T6' 

'FP1' ‘Fp2'});  

pop_chanedit (chanlocs); 

Gli ele@rodi tra le parentesi graffe sono tuG quelli che compaiono nei canali del 

segnale. 
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Figura 5.1: Finestra di EEGLAB per l’inserimento delle Channel LocaMons 

Salvando le Channel locaMons in un file .ced, queste possono essere le@e da quel file , 

senza doverle reinserire ogni volta che viene caricato il segnale. 

Viene rifa@o il referenziamento rispe@o alla media, con lo stesso procedimento 

effe@uato prima. 

La baseline è stata rimossa, selezionando Tools -> Remove epoch baseline e poi viene 

effe@uato il filtraggio. Viene applicato il filtro FIR di default su EEGLAB, in parMcolare si 

usa un filtro passa-alto a 0.5 Hz e un filtro passa-basso a 70 Hz; non è stato effe@uato il 

filtraggio con il filtro notch a 50 Hz (rumore di linea) perché è già stato applicato. Si 

seleziona Tools -> Filter the data -> Basic FIR filter (new, default); si apre una finestra 

dove possono essere inserite le frequenze di taglio del filtro e poi si preme Ok in modo 

che il programma filtri il segnale. 

Nell’ulMma fase del preprocessamento viene fa@a l’Analisi delle ComponenM 

IndipendenM (ICA: Indipendent Component Analisys): Tools -> Decompose data by ICA 

e si seleziona l’algoritmo runica (default) e poi Ok. 

Dopo aver individuato le componenM indipendenM del segnale, si vanno a classificare: 

Tools -> Classify components using ICLabel -> Label components. Viene scelta la 

versione delle ICLabel di default e si clicca Ok. Terminate le ICLabel appare un pannello 

che perme@e di plo@arle e si seleziona Ok. 
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Vengono eliminate manualmente le componenM più rumorose: Tools -> Remove 

components from data; si apre una finestra, nella quale vengono inseriM i numeri delle 

componenM da rimuovere (3,9,12) e si preme Ok. Appare un’altra finestra con la quale 

visualizzare il mio segnale, prima e dopo la rimozione delle componenM, e decidere se 

acce@are l’eliminazione o se reinserire le componenM. Selezioniamo Accept per 

effeGvamente eliminare le componenM selezionate precedentemente. 

Per studiare il ritmo Delta si fa un filtraggio, con lo stesso procedimento effe@uato nel 

preprocessamento, con un filtro passa-banda con frequenze di taglio pari a quelle delle 

onde Delta (0.5-4 Hz). 

5.3 RisultaR oHenuR 

Dopo aver caricato il segnale, appare la schermata iniziale di EEGLAB che mostra le 

varie cara@erisMche del segnale caricato: nome, numero di canali, frequenza di 

campionamento, posizioni degli ele@rodi, grandezza del database, ecc.  

Avendo referenziato rispe@o alla media, sul pannello iniziale verrà scri@o ‘average‘ 

vicino a reference (Figura 5.2). 

 

Figura 5.2: È rappresentata la schermata che vediamo in EEGLAB dopo aver caricato il 

segnale e aver fa@o il referenziamento. Mostra tu@e le principali cara@erisMche del 

segnale, tra cui la scri@a ‘average’ che indica il referenziamento rispe@o alla media. 
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Dopo aver inserito le Channel LocaMons si può visualizzare la disposizione degli 

ele@rodi sullo scalpo; in Figura 5.3 viene mostrato lo scalpo in 2D con tuG gli ele@rodi 

usaM nel montaggio bipolare; mentre la Figura 5.4 riporta lo scalpo con i soli ele@rodi 

primari. 

Figura 5.3: Rappresenta i 16 ele@rodi usaM per rilevare il segnale con le derivazioni 

bipolari; alcuni ele@rodi sembra si trovino al di fuori dello scalpo, ma in realtà si 

trovano al di so@o dello scalpo raffigurato, quindi nella parte bassa della testa. 

Figura 5.4: Plot in 2D di tuG i primi ele@rodi dei vari canali 
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Dopo aver applicato il filtro, è possibile verificare che esso sia stato applicato 

corre@amente visualizzando lo spe@ro di tuG i canali del segnale (Figura 5.5) o 

sovrapponendo il segnale iniziale con quello filtrato nel tempo (Figura 5.6). Per 

visualizzare i segnali sovrapposM si uMlizza la funzione eegplot(), che prende in ingresso 

la matrice del dato da plo@are e se viene specificato ‘data2’, si può inserire in ingresso 

l’array che conMene il secondo dato, il quale deve essere della stessa dimensione del 

primo e verrà plo@ato al di sopra. 

Figura 5.5: Spe@ro delle componenM del segnale dopo il filtraggio tra 0.5 e 60 Hz 

Figura 5.6: Plot sovrapposM del segnale rumoroso (blu) e del segnale filtrato (rosso) 
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Dopo aver scomposto il segnale con le ICA, nel pannello mostrato in Figura 5.2 appare 

la scri@a ‘Yes’ in corrispondenza di ICA weights; si possono plo@are le componenM 

indipendenM nel tempo (Figura 5.7) o in mappe bidimensionali (Figura 5.8) o 

tridimensionali (Figura 5.9) che rappresentano le zone dello scalpo in cui è concentrato 

il generatore di ogni componente. 

Figura 5.7: Andamento delle ComponenM IndipendenM nel tempo 

Figura 5.8: Mappe bidimensionali delle ComponenM IndipendenM  
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Figura 5.9: Mappe tridimensionali delle ComponenM IndipendenM 

Classificando le componenM indipendenM con l’ICLabel, si oGene, oltre alle mappe 

bidimensionali mostrate in figura 5.8, la percentuale della classe che ha più probabilità 

di rappresentare la componente (Figura 5.10). Se viene selezionato il numero sopra 

ogni mappa, si possono osservare tu@e le percentuali relaMve ai vari contribuM che 

influenzano quella componente (Figura 5.11). 

Figura 5.10: Classificazione delle componenM mediante ICLabel 
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Figura 5.11: Viene mostrata la mappa bidimensionale della Componente Indipendente 

9 e le relaMve percentuali o@enute mediante la classificazione con ICLabel 

Eliminate le 3 componenM più rumorose, si può verificare che la loro rimozione abbia 

ripulito il segnale, sovrapponendo il segnale preprocessato con quello senza le 

componenM rumorose. La Figura 5.12 riporta la sovrapposizione del segnale 

preprocessato con il segnale senza la componente rumorosa 3 e la Figura 5.13 la 

sovrapposizione del primo con il segnale senza le tre componenM più rumorose (3, 9, 

12). 

Figura 5.12: Sovrapposizione del segnale preprocessato (blu) con il segnale dopo la 

rimozione della componente 3, dovuta al movimento oculare (rosso) 
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Figura 5.13: Sovrapposizione del segnale preprocessato (blu) e del segnale dopo la 

rimozione delle tre componenM rumorose: 3, 9, 12 (rosso) 

Avendo selezionato il range di frequenze delle onde Delta, si possono ricavare 

nuovamente l’andamento temporale e lo spe@ro del segnale (Figura 5.14), che 

conterranno soltanto le componenM che hanno frequenza tra 0.5-4 Hz. 

Figura 5.14: Spe@ro del segnale dopo il filtraggio tra 0.5 e 4 Hz 
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Scorrendo il segnale ripulito nel tempo, è stato possibile individuare dei traG in 

corrispondenza dei quali sono avvenuM degli a@acchi nel paziente (Figura 5.15(A), 

Figura 5.16(A)), cara@erizzate dagli andamenM epileGformi descriG nel capitolo 4. In 

corrispondenza di quesM a@acchi è stato osservato anche l’andamento delle onde 

delta. 

Figura 5.15: Segnale ele@roencefalografico acquisito durante una crisi epileGca (A) e 

onde delta acquisite durante la stessa crisi (B) nel sogge@o 1 
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Figura 5.16: Acquisizione del segnale ele@roencefalografico nel tempo durante e 

precedentemente una crisi (A) e andamento delle onde delta del tempo acquisite 

prima e durante la crisi nello stesso intervallo di tempo (B) nel sogge@o 1 

Effe@uando la stessa analisi e preprocessamento anche sui soggeG 2 e 7, si riesce ad 

o@enere l’andamento temporale dei segnali dei vari canali e l’andamento delle onde 

delta nel tempo, che possono essere paragonaM, come fa@o con il sogge@o 1. 

QuesM andamenM sono riportaM nelle figure 5.17, 5.18 e 5.19. 
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Figura 5.17: Segnale ele@roencefalografico acquisito durante una crisi epileGca (A) e 

onde delta acquisite durante la stessa crisi (B) nel sogge@o 2 
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Figura 5.18: Tra@o del segnale ele@roencefalografico durante una crisi epileGca (A) e 

andamento delle onde delta durante la stessa crisi (B) nel sogge@o 3 

37



 

 

Figura 5.19: Tracciato ele@roncefalografico non in prossimità di una crisi (A) e onde 

delta nello stesso tra@o (B) nel sogge@o 3 
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5.4 Discussione 

Facendo una ricerca sui vari DataBase presenM in Physionet, è stato scelto il CAP Sleep 

Database in quanto raccoglie segnali polisonnografici, tra cui ele@roencefalogrammi a 

molteplici canali, rilevaM da 40 diversi soggeG affeG da SHE. Essendo la SHE 

considerata una malaGa rara, è difficile trovare un database come questo che raccoglie 

i segnali di un grande numero di soggeG affeG da essa. La presenza di segnali che 

provengono da più soggeG malaM perme@e un’analisi più completa, in modo da 

o@enere delle conclusioni il più generali possibili e non ristre@e ad un solo caso. 

I daM raccolM per ogni paziente contengono 22 segnali polisonnografici, tra cui un EEG a 

13 canali con montaggio bipolare. 

Vengono consideraM e quindi caricaM in EEGLAB solo i primi 12 canali dell’EEG, 

eliminando l’ulMmo (C4-A1), in quanto in una fase successiva del processamento 

(Classify components using ICLabel -> Label components) è richiesta simmetria. È stato 

eliminato il canale C4-A1 perché l’ele@rodo A1 è quello che rende asimmetrica la 

disposizione degli ele@rodi sullo scalpo e inoltre l’ele@rodo C4 è già presente nel terzo 

canale dell’EEG (C4-P4), per cui la perdita di informazione legata al canale risulta 

minore. 

Come già de@o nei paragrafi precedenM, i segnali del CAP Sleep Database presentano 

montaggi bipolari, mentre EEGLAB opera normalmente con derivazioni unipolari. Il 

caricamento dei daM non ha mostrato problemi, ma negli step successivi del 

preprocessamento si presentavano degli errori dovuM alla natura bipolare delle 

derivazioni; per ovviare al problema tuG i canali sono staM riportaM ad un unico 

riferimento mediante il referenziamento rispe@o alla media dei segnali, in modo da 

riuscire poi ad inserire le Channel LocaMons. 

Vengono inserite le Channel LocaMons solo dei primi ele@rodi in quanto il contributo 

dei secondi ele@rodi viene so@ra@o dai primi, i quali rappresentano quindi il principale 

contribuito dei segnali. 

Dopo aver rimosso la baseline, non si sono presentate differenze nell’andamento 

temporale del segnale o@enuto rispe@o a quello iniziale, infaG nelle specifiche 

presenM all’interno del database la baseline dei segnali è a 0. 

Come de@o nel Capitolo 2, le frequenze più rilevanM dell’EEG si trovano tra 0.5 e 30 Hz; 

se venisse applicato al segnale un filtro con queste frequenze di taglio, verrebbe 

eliminato quasi tu@o il rumore e le componenM artefa@uali, ma andrebbe perso tu@o il 

contributo delle onde con frequenza >30 Hz. Nello spe@ro del segnale, come mostrato 

nel Capitolo 2, le componenM ad alta frequenza hanno una minore ampiezza rispe@o a 

quelle a bassa frequenza ma se completamente eliminate verrebbe distorto il segnale 
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prelevato, quindi ho scelto di mantenere le componenM fino a 60 Hz, che risultano uMli 

per interpretare al meglio il segnale e per fare una valutazione più affidabile.  

Dallo spe@ro delle componenM si può osservare che il filtro è stato applicato 

corre@amente, in quanto le bande minori di 0.5 Hz e maggiori di 60 Hz, dopo una certa 

banda di transizione (che possiamo vedere in Figura 5.5), vengono portate verso lo zero 

e quindi eliminate. 

Il filtro uMlizzato è un filtro reale, dunque la banda passante non inizia precisamente a 

0.5 Hz e non termina a 60 Hz ma sono presenM delle regioni transitorie, per cui una 

parte delle frequenze che si vogliono eliminare rimane nel segnale filtrato. 

In Figura 5.6 si può osservare che il segnale filtrato, in rosso, risulta più vicino e più 

centrato rispe@o alla baseline, quindi sono state rimosse le componenM a bassa 

frequenza, legate a disturbi in questa banda, come il movimento degli occhi e l’eye-

blinking (baGto della palpebra); i segnali risultano anche più “puliM” grazie 

all’eliminazione dei disturbi ad alta frequenza, che possono essere tremori muscolari, 

movimenM del paziente o artefaG da rete (disturbi ele@romagneMci). 

Il segnale non è stato filtrato con il filtro Notch a 50 Hz per eliminare il rumore di rete 

perché è stato già applicato ai segnali presenM nel database; infaG, come si nota dallo 

spe@ro delle componenM dopo il filtraggio, è presente un picco verso il basso in 

corrispondenza dei 50 Hz, che ne indica l’eliminazione (visibile in figura 5.5). 

L’Analisi delle ComponenM IndipendenM è una tecnica che perme@e di eliminare, in 

maniera più precisa rispe@o al semplice filtraggio, i disturbi che si possono sovrapporre 

al segnale e quindi di isolare e considerare solo le componenM “buone”. Il segnale 

rilevato da ciascun ele@rodo è composto dall’insieme di più contribuM che derivano da 

molteplici generatori, posizionaM in diverse zone della corteccia cerebrale; quesM 

generatori sono gruppi di neuroni corMcali che producono un’aGvità sincrona, e quindi 

rilevabile. L’ICA scompone il segnale iniziale in componenM tra loro indipendenM,  

riconducibili al segnale proveniente da ciascun generatore e di numero pari a quello dei 

canali; nel nostro caso avremo 12 componenM. Così scomponendo il segnale, viene 

individuata la zona della corteccia cerebrale che influenza maggiormente ciascuna 

componente. 

Visualizzando le componenM indipendenM nel tempo, in Figura 5.7, è possibile 

analizzare il comportamento delle varie tracce, in quanto i vari disturbi hanno dei 

comportamenM cara@erisMci. La componente 3 può essere associata al movimento 

oculare, che appare sull’EEG come un’onda di ampiezza superiore rispe@o 

all’andamento di fondo e si va a ripetere nel tempo ogni volta che il sogge@o muove 

l’occhio o sba@e le palpebre. 
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La componente 12 risalta rispe@o alle altre per la sua ampiezza ne@amente inferiore; 

andando ad ingrandire solo quella componente (Figura 5.20), si osservano delle 

variazioni ad alMssima frequenza, che possono essere associate ad un artefa@o dovuto 

a movimento muscolare o a disturbi ele@romagneMci esterni. 

Grazie alla decomposizione mediante l’ICA, è possibile visualizzare la zona che più 

influenza ciascuna componente, cioè l’area in cui si trova il generatore (il gruppo di 

cellule che generano il segnale) di ogni componente, con delle mappe bidimensionali in 

cui le zone che contribuiscono maggiormente alla componente sono evidenziate in 

rosso. 

Confrontando le osservazioni dedo@e dall’andamento delle componenM nel tempo con 

le mappe bidimensionali, in Figura 5.8, si vede una corrispondenza tra l’andamento 

temporale e la posizione del generatore della componente 3. La mappa 3 conferma che 

il generatore è posto a livello dell’occhio ed è quindi una componente artefa@uale del 

segnale. La sua localizzazione è ancora più visibile nelle mappe tridimensionali, in 

figura 5.9, dove si nota che la zona che la influenza è quella frontale e quindi 

comprende anche la zona oculare. 

Un’altra possibile componente artefa@uale che non è visibile nell’andamento 

temporale è la 9, in quanto sia nella mappa bidimensionale che in quella 

tridimensionale la localizzazione del generatore è nelle vicinanze dell’occhio. Non 

comparendo nell’andamento temporale la classica onda che indica l’eye-blinking, come 

nella componente 3, l’artefa@o potrebbe essere dovuto al movimento laterale 

dell’occhio. 

Figura 5.20: Andamento nel tempo della Componente Indipendente 12 
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Le mappe tridimensionali mostrate perme@ono di osservare più de@agliatamente la 

zona in cui è concentrato il generatore di ciascuna componente; in Figura 5.9 non è 

possibile vedere le zone di generazione di alcune mappe, ma all’interno del programma 

c’è la possibilità di poterle ruotare, per cui risulta uno strumento molto uMle nel caso in 

cui non riuscissimo ad interpretare in modo soddisfacente la mappa bidimensionale. 

Le osservazioni fa@e finora si basano sull’interpretazione delle varie immagini o@enute, 

e quindi dipendono dall’esperienza di chi le osserva; esiste uno strumento più 

oggeGvo che perme@e una classificazione automaMca delle componenM e rende più 

intuiMva la scelta di quelle da eliminare. 

Le componenM possono essere di diverso Mpo: 

• Cerebrale (Brain) 

• Oculare (Eye) 

• Muscolare (Muscle) 

• Cardiaco (Heart) 

• Rumore di Linea (Line Noise) 

• Rumore del canale (Channel Noise) 

• Altro (Other), che comprende tu@e le tracce influenzate da rumore non idenMficato o 

i traG che non sono staM decomposM corre@amente dal’ICA 

Ad ogni Mpo di componente è assegnata una classe, che prende lo stesso nome. 

L’operazione di classificazione automaMca viene fa@a mediante un plugin, chiamato 

ICLabel, il quale assegna per ogni componente le varie percentuali delle classi che la 

influenzano. 

Vengono specificate le osservazioni e i procedimenM faG sul sogge@o 1; per gli altri 

due soggeG le operazioni e le osservazioni fa@e sono dello stesso Mpo ma le 

componenM eliminate saranno diverse, in base a dove si concentrano le componenM 

artefa@uali. 

Facendo l’ICLabel nel segnale in quesMone si può vedere che, come ci si aspe@ava dalle 

osservazioni precedenM, la componente 3 è quasi totalmente (93.4%) influenzata 

dall’eye-blinking e verrà quindi eliminata. Essendo una componente quasi 

completamente artefa@uale, si vuole mostrare come varia il segnale originale dopo la 

sua eliminazione, in Figura 5.12; i canali che sono staM più influenzaM dalla sua 

eliminazione sono il primo e il seGmo, relaMvi rispeGvamente agli ele@rodi Fp2 e Fp1. 

Gli ele@rodi Fp1 e Fp2 si trovano infaG, come si può vedere in Figura 5.4, nella parte 

frontale della testa e quindi vicino agli occhi. L’eliminazione della componente 3 ha 

permesso di rimuovere i classici artefaG da eye-blinking, che comparivano nel segnale 

preprocessato. 
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La componente 9, come si osserva dalla Figura 5.10, è formata per il 58.9% da artefaG 

oculari; selezionando la casella 9 che si trova sopra la mappa si o@engono le 

percentuali che indicano la probabilità di appartenenza alle altre classi: l’appartenenza 

alla classe Brain è del 5.1%. La componente 9 è sicuramente una componente 

artefa@uale e sarà quindi eliminata. 

L’ulMma possibile componente artefa@uale di cui è stato discusso prima, è la 12. La 

componente 12 apparMene per il 52.2% alla categoria Other; selezionando il tasto 

sopra la mappa vediamo che la componente Brain è del 3.9% e risalta la parte Muscle 

che è pari al 37.7%; questo conferma quello che si era dedo@o dall’andamento 

temporale. Viene rimossa anche la componente 12. 

Analizzando le altre componenM, quella che ha contributo cerebrale più basso è la 

componente 5 (Brain: 22.4%); la scelta di non eliminarla è dovuta al fa@o che, 

rimuovendo già 3 componenM e avendo pochi canali (12), rimarrei con sole 8 

componenM e si rischierebbe di perdere troppe informazioni uMli. 

Osservando la figura 5.13, si può notare che i canali più affeG dalla rimozione delle 

componenM sono staM quelli legaM agli ele@rodi Fp1 e Fp2, che hanno un’aGvità con 

ampiezza bassa rispe@o agli altri canali. Se si fa un paragone tra la Figura 5.12 e la 

Figura 5.13, si deduce che il maggior contributo artefa@uale era dato dalla componente 

3, infaG tra le due immagini la differenza è minima; la rimozione della componente 9 

ha rido@o ulteriormente gli artefaG oculari, mentre la componente 12 ha rimosso il 

rumore muscolare ad alta frequenza. 

Secondo uno studio effe@uato nel 2012 [30], gli EEG di pazienM affeG da SHE hanno 

delle cara@erisMche comuni, che sono quelle elencare nel paragrafo 4.2. 

Tra queste c’è l’aumento del SWS e un maggior numero di CAP-A1, che sono aGvità 

legate alle onde Delta: il sonno SWS è definito come l’insieme delle fasi 3 e 4 del sonno 

NREM, cara@erizzate da ritmi lenM (onde Delta); a loro volta, i cicli CAP classificaM A1 

sono formaM da fasi A con aGvità sincronizzata, quindi da un EEG con onde ad elevata 

ampiezza e bassa frequenza. 

Per quesM moMvi, le onde Delta sono state il ritmo studiato nei segnali consideraM.  

Secondo la le@eratura [33], l’aGvità delle onde delta risulta predominante nei canali di 

ele@rodi in posizione controlaterale rispe@o all’onset della crisi. Non è stato però 

possibile valutare questo aspe@o, in quanto per segnali analizzaM non era disponibile 

alcuna informazione riguardante la zona di origine della crisi. 
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Scorrendo il segnale ripulito nel tempo del primo sogge@o, si è visto che il suo EEG a 

baseline non presentava anomalie nelle onde delta, ma queste ulMme risultavano 

parMcolarmente pronunciate durante le crisi no@urne. 

In corrispondenza di entrambe le crisi mostrate nelle figure 5.15 e 5.16, è stato 

riscontrato che le onde Delta hanno un’ampiezza maggiore rispe@o a quelle nei canali 

che non sono affeG dagli a@acchi e rispe@o al loro andamento nei traG di segnale in 

cui il paziente non è sogge@o alle crisi. 

Nella figura 5.16 le onde Delta sembrano interessare anche il tra@o appena precedente 

la crisi, quindi possono essere uMlizzate come un segnale per riuscire a rilevare un 

a@acco successivo. 

Analizzando il sogge@o 2 viene confermato, come si vede in figura 5.17, il fa@o che in 

corrispondenza di crisi no@urne si hanno onde delta più ampie e numerose, mentre nel 

sogge@o 7 questo comportamento risulta essere molto meno evidente. 

Il terzo sogge@o analizzato ha presentato un andamento diverso rispe@o agli altri due:  

sono presenM un numero inferiore di crisi durante il monitoraggio, per cui non è molto 

presente il Mpico pa@ern epileGforme, e quando presente, non si osservano variazioni 

anomale del ritmo delta in corrispondenza delle crisi. In figura 5.18, si osserva che 

l’andamento delle onde delta sembra essere piu@osto simile per tuG i canali e non si 

vedono parMcolari variazioni sui canali che registrano maggiormente la crisi; ci sono 

delle onde delta di ampiezza maggiore rispe@o alle altre, ma sembrano fru@o di 

artefaG rimasM nel segnale piu@osto che della crisi in corso. 

Scorrendo il segnale nel tempo, sono staM trovaM dei traG che presentano un 

andamento cara@erisMco delle fasi 3 e 4 del sonno NREM. La durata di quesM traG 

risulta essere molto lunga e ciò è in accordo con quello trovato in le@eratura, in base 

alla quale i soggeG affeG da SHE presentano una maggiore durata delle fasi lente del 

sonno (S3 e S4). Questo andamento cara@erisMco è stato mostrato in figura 5.19; 

essendo gli stadi  3 e 4 del sonno cara@erizzaM da un ritmo delta predominante rispe@o 

agli altri ritmi più veloci, quando il ritmo delta viene isolato (Figura 5.19(B)) esso risulta 

molto più pronunciato rispe@o agli altri casi. 
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Conclusione 

Lo scopo della tesi era valutare l’andamento e l’ampiezza delle onde a bassa frequenza, 

onde delta, in soggeG affeG da SHE per vedere se era quesM ritmi presentavano 

andamenM anomali e se era possibile rilevarli in maniera automaMca. Si voleva inoltre 

verificare se i risultaM o@enuM fossero conformi alla le@eratura. 

Tra i soggeG tra@aM è stato osservato che per due soggeG su tre (sogge@o 1 e 2) le 

onde delta non presentano alcuna anomalia quando i pazienM non sperimentano 

alcuna crisi, mentre si presentano in numero e in ampiezza maggiori rispe@o al 

normale in corrispondenza (poco prima, durante e poco dopo) degli a@acchi epileGci.  

In corrispondenza di alcune crisi, in parMcolare nel sogge@o 1, è stato possibile vedere 

che le onde delta aumentano in numero anche nel momento appena precedente la 

crisi; questa informazione potrebbe essere sfru@ata per fare una migliore valutazione 

del sogge@o e, insieme ad altri traG cara@erisMci della SHE, potrebbe aiutare nella 

diagnosi della malaGa.  

Nell’ulMmo sogge@o studiato, non si sono presentate molte crisi durante il 

monitoraggio, per cui l’analisi si è concentrata sulle anomalie che si possono trovare 

nell’EEG interictale, quindi nei traG che non presentano a@acchi. Anche in questo caso 

sono state confermate le osservazioni presenM in le@eratura, per le quali i soggeG 

affeG da SHE presentano delle fasi lente del sonno più lunghe. Questo andamento è 

stato riscontrato nell’EEG del sogge@o 7, il cui EEG presenta prevalentemente onde 

lente, e quindi onde delta. 

Sono staM quindi trovaM due andamenM cara@erisMci che si possono presentare negli  

EEG di individui affeG da SHE e che quindi possono migliorare la diagnosi nei casi in cui 

non si disponesse di esami più specifici, come ad esempio un video-EEG. Inoltre, la 

presenza di anomalie anche nei traG a baseline è importante, perché perme@e di 

risolvere uno dei problemi presentaM in precedenza, cioè il fa@o che non sempre, 

sopra@u@o nel caso di periodi di monitoraggio corM, si riescono a registrare crisi in 

a@o. Grazie a queste anomalie nelle onde delta e nel periodo delle onde lente del 

sonno, è possibile fare una prima diagnosi a parMre da un EEG che non presenta 

pa@ern epileGformi. 

Infine si è visto come l’uMlizzo di un so�ware, in questo caso di EEGLAB, risulta 

fondamentale per esaminare i tracciaM ele@ronencefalografici, in quanto ha permesso 

un’analisi veriMera e affidabile, che non sarebbe stata tale esaminando l’EEG iniziale 
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rumoroso. I metodi automaMci possono essere di grande supporto al medico (per 

esempio, per la diagnosi clinica) perché, se affidabili, sono oggeGvi e in genere veloci, 

ma l'esperienza di un medico è sempre un fa@ore essenziale, a cui un metodo 

automaMco non può sosMtuirsi; quindi, da preferirsi è la competenza e l'esperienza di 

un clinico, supportato da un buon metodo automaMco che fornisce un'analisi oggeGva, 

ripeMbile e possibilmente veloce. 
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